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EMC Smarts Integration Guide

The EMC Smarts Integration Guide describes how to integrate vCenter Operations Manager and EMC Smarts.

Intended Audience
The information in this guide is intended for IT management and system administrators.
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Updated Information

The EMC Smarts Integration Guide is updated with each release of the product or when necessary.

This table provides the update history of the EMC Smarts Integration Guide.

Revision Description

EN-000540-10 n Changed the product name to reflect the new licensing model for the 5.6 release.
n Modified the adapter instance test step in “Add an Adapter Instance,” on page 16 for the 5.6 release.

EN-000540-09 n Added information about the Server Kind drop-down menu to “Add an Adapter Instance,” on
page 16.

n Added Chapter 5, “Troubleshooting the EMC Smarts Adapter,” on page 37.
n Added more information to the installation instructions in “Install the Adapter in a Standalone

Installation,” on page 11and “Install the Adapter in a vApp Installation,” on page 12.

EN-000540-08 Added limitation information to “Read Events From Notification Lists,” on page 28.

EN-000540-07 n Added information about enabling smart discovery. See “Enable Smart Discovery,” on page 29
n Added information about configuring how the adapter handles processor metrics. See “Configure How

the Adapter Handles Smarts Processor Metrics,” on page 30.
n Added information about finding nonexistent EMC Smarts resources in the

vCenter Operations Manager user interface. See “Finding Nonexistent EMC Smarts Resources,” on
page 36.

n Added EMC Smarts 9.0 support to “EMC Smarts Compatibility Requirements,” on page 10.
n Corrected the default domain for the INCHARGE-AM-PM-SUITE in step 8 in “Add an Adapter

Instance,” on page 16.

EN-000540-06 Added information about configuring the adapter to read events from notification lists. See “Read Events
From Notification Lists,” on page 28.

EN-000540-05 Added information about testing an adapter instance that uses an EMC Smarts SecureBroker Credentials
credential kind to “Add an Adapter Instance,” on page 16.

EN-000540-04 Added a new credential type to “Add a Credential,” on page 17 for Secure Broker mode.

EN-000540-03 Corrected step 3 in “Install and Configure Integration Tools Files,” on page 21. Step 3 now instructs you
to modify the Launch-vcops-UI-Object.cmd file.

EN-000540-02 Added information about downloading and installing the Launch-vcops-UI-Object.cmd, launch-
vcops-action-windows.xml, and vcops_emc.jar files to “Install the Adapter in a vApp Installation,” on
page 12.

EN-000540-01 Changed vCenter Operations Enterprise to vCenter Operations Manager.

EN-000540-00 Initial release.
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Introduction to EMC Smarts
Integration 1

Integrating vCenter Operations Manager and EMC Smarts improves the performance of both products and
makes it easier to predict, diagnose, and prevent problems in your IT infrastructure.

This chapter includes the following topics:

n “Data that vCenter Operations Manager Receives from EMC Smarts,” on page 9

n “Data that vCenter Operations Manager Sends to EMC Smarts,” on page 9

n “Installation and Configuration Requirements,” on page 10

n “Overview of Data Flow,” on page 10

Data that vCenter Operations Manager Receives from EMC Smarts
vCenter Operations Manager receives definitions of resources and metric values for attributes that EMC servers
monitor in domains that you select. It also receives topology information for container resources that EMC
Smarts defines.

vCenter Operations Manager uses the topology information that it receives from EMC Smarts to define
container resources, including applications and tiers, in vCenter Operations Manager. Once each day, at a time
that you configure, vCenter Operations Manager polls each EMC Smarts adapter instance and adds any new
resources that it finds. This feature ensures that the vCenter Operations Manager resource topology always
matches the EMC Smarts topology.

EMC Smarts generates change events when resources are unavailable and anomalies when resources are
unresponsive. The change events appear in vCenter Operations Manager in the Mashup Charts widget and
on the Mashup tab on the Alert Detail page for alerts on the associated resource. The
vCenter Operations Manager analytics engine considers the anomalies as possible root cause symptoms for
related alerts.

See “Viewing EMC Smarts Information in vCenter Operations Manager,” on page 34 for examples of how
EMC Smarts information appears in the Custom user interface.

Data that vCenter Operations Manager Sends to EMC Smarts
vCenter Operations Manager uses its advanced analytics to analyze metric data that it receives from EMC
Smarts and sends alert messages back to EMC Smarts when it detects problems or potential problems.

Alerts that vCenter Operations Manager sends to EMC Smarts appear in the Global Console Notification Log.
An operator can double-click an alert message to see more information about the alert in the
vCenter Operations Manager custom view panel. From the custom view panel, an operator can click an arrow
to open the Alert Detail page in vCenter Operations Manager.
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For more information about these features and how to use them, see “Viewing Alerts in EMC Smarts,” on
page 31.

NOTE   The Global Console is called the EMC Smarts Global Console in EMC Smarts 7.x and the EMC Ionix
Global Console in EMC Smarts 8.1 and 9.0.

Installation and Configuration Requirements
Before you configure EMC Smarts integration, verify that your system meets EMC Smarts compatibility and
credential requirements.

EMC Smarts Compatibility Requirements
vCenter Operations Manager supports EMC Smarts 7.x, 8.1, and 9.0.

NOTE   For EMC Smarts 9.0, the EMC Smarts adapter can retrieve metrics and events and send alerts, but it is
not validated for the vCenter Operations Manager integration tools or the Global Console custom view.

Credential Requirements
You must have a valid EMC Smarts user name and password to create an EMC Smarts adapter instance.

Overview of Data Flow
When you integrate vCenter Operations Manager and EMC Smarts, data moves back and forth among certain
components of each product.

Figure 1-1.  EMC Integration Data Flow
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Installing the EMC Smarts Adapter 2
The EMC Smarts adapter is an embedded adapter for vCenter Operations Manager. The adapter collects
metrics, change events, and resource topology information from EMC Smarts.

The procedure you follow to install the EMC Smarts adapter depends on whether you have a
vCenter Operations Manager Standalone or vApp installation.

This chapter includes the following topics:

n “Install the Adapter in a Standalone Installation,” on page 11

n “Install the Adapter in a vApp Installation,” on page 12

Install the Adapter in a Standalone Installation
If you have a standalone installation, you install the EMC Smarts adapter by extracting the adapter installation
files from a TGZ file and running an installation utility.

Prerequisites

n Download the adapter installation TGZ file anonymously from ftp://ftp.integrien.com/.

n Make a note of the build number in the TGZ file name. The build number appears after the adapter name,
for example, adaptername-buildnumber.tgz.

n Read the release notes that are included with the TGZ file.

Procedure

1 Open the TGZ file and extract the TAR file to a temporary folder on your vCenter Operations Manager
server.

2 In the temporary folder, open the TAR file and extract and run the installer for your operating system
platform.

3 Log in to the Custom user interface as an administrator.

4 Select Admin > Support.

5 On the Info tab, find the Adapters Info pane and click the Describe icon ( ).

The Describe icon is located at the top right of the Adapters Info pane.

VMware, Inc.  11
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6 Click Yes to start the describe process and click OK.

The Custom user interface finds the adapter files, gathers information about the abilities of the adapter,
and updates the user interface with information about the adapter. If you have remote collectors, it installs
the adapter on the remote collectors.

The describe process might take several minutes. When the describe process is finished, the adapter
appears in the Adapters Info pane. The build number is in the Adapter Version column.

7 Verify that the build number in the Adapter Version column for the adapter matches the build number in
the TGZ file that you downloaded.

Install the Adapter in a vApp Installation
If you have a vApp installation, you install the EMC Smarts adapter from a PAK file.

Prerequisites

n Download the adapter installation PAK file from ftp://ftp.integrien.com.

n Download the Launch-vcops-UI-Object.cmd, launch-vcops-action-windows.xml, and vcops_emc.jar files
from the EMC-Smarts/GlobalConsoleCustomView folder on ftp://ftp.integrien.com.

n Read the release notes that are included with the PAK file.

Procedure

1 Save the PAK file in a temporary folder.

2 Save the Launch-vcops-UI-Object.cmd, launch-vcops-action-windows.xml, and vcops_emc.jar in any
folder.

You use these files on the EMC Smarts server when you configure the Global Console custom view.

3 Log in to the Admin user interface as the admin user.

For example: https://ipaddress/admin/

4 On the Update tab, click Browse to locate the temporary folder and select the PAK file.

5 Click Update and click OK to confirm the update.

The Admin user interface uploads the PAK file. The upload might take several minutes.

6 Read and accept the EULA and click OK.

7 Click OK to confirm and start the update process.

The update might take several minutes. Status information appears on the Update tab when the update
is finished.

8 Log in to the Custom user interface as an administrator.

For example: https://ipaddress/vcops-custom/

9 Select Admin > Support.

10 On the Info tab, find the Adapters Info pane and click the Describe icon ( ).

The Describe icon is located at the top right of the Adapters Info pane.

11 Click Yes to start the describe process and click OK.

The Custom user interface finds the adapter files, gathers information about the abilities of the adapter,
and updates the user interface with information about the adapter.

The describe process might take several minutes. When the describe process is finished, the adapter
appears in the Adapters Info pane. The build number is in the Adapter Version column.
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12 Verify that the build number in the Adapter Version column for the adapter matches the build number in
the PAK file that you uploaded.

Chapter 2 Installing the EMC Smarts Adapter
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Configuring EMC Smarts Integration 3
To configure EMC Smarts integration, you must perform procedures in vCenter Operations Manager and EMC
Smarts.

This chapter includes the following topics:

n “Overview of Configuration Steps,” on page 15

n “Add an Adapter Instance,” on page 16

n “Discover Resources,” on page 18

n “Configuring Outbound Alerts,” on page 19

n “Installing and Configuring the Global Console Custom View,” on page 20

n “Installing and Configuring Integration Tools in EMC Smarts,” on page 21

n “Configuring EMC Smarts Adapter Properties,” on page 23

Overview of Configuration Steps
Configuring EMC Smarts integration involves several steps. You must perform these steps in a particular order.

1 Verify that your system meets installation and configuration requirements. See “Installation and
Configuration Requirements,” on page 10.

2 Verify that EMC Smarts is collecting data from its monitored resources.

3 Add an EMC Smarts adapter instance. See “Add an Adapter Instance,” on page 16.

4 If you disable auto-discovery when you add an adapter instance, manually discover resources. See 
“Discover Resources,” on page 18.

5 Configure vCenter Operations Manager to send alerts to EMC Smarts. See “Configuring Outbound
Alerts,” on page 19.

6 Install and configure the vCenter Operations Manager custom view for the Global Console. See “Installing
and Configuring the Global Console Custom View,” on page 20.

7 Install and configure the vCenter Operations Manager integration tools in EMC Smarts. See “Installing
and Configuring Integration Tools in EMC Smarts,” on page 21.

8 (Optional) Modify EMC Smarts adapter properties. See “Configuring EMC Smarts Adapter Properties,”
on page 23.
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Add an Adapter Instance
You must add an adapter instance for each EMC Smarts domain from which vCenter Operations Manager
collects data. When you add an adapter instance for the EMC Smarts adapter, you define the adapter type,
identify the EMC broker and EMC Smarts domain, and select or add a credential.

Prerequisites

n Install the EMC Smarts adapter. See Chapter 2, “Installing the EMC Smarts Adapter,” on page 11.

n Create a credential or, if you plan to create a credential when you add the adapter, become familiar with
creating credentials. See “Add a Credential,” on page 17.

Procedure

1 Log in to the Custom user interface as an administrator.

2 Select Environment > Configuration > Adapter Instances.

3 Select the collector to use from the Collector drop-down menu.

Unless you added additional collectors, the only available collector is vCenter Operations Server. You
can change the name of this collector when you install the standalone version.

4 Select EMC Smarts from the Adapter Kind drop-down menu.

5 Click the Add New Adapter Instance icon.

6 Type a name for the adapter in the Adapter Instance Name text box.

7 Type the host name or IP address of the EMC broker and the port number that it listens on in the
Broker text box.

Use a colon to separate the host name or IP address and the port number.

For example, if the IP address of the EMC broker is 123.45.6.789 and it listens on the default EMC port
(426), type 123.45.6.789:426.

8 Type the name of the EMC Smarts domain to attach to in the Manager text box.

The default domain for the INCHARGE-AM-PM-SUITE server kind is INCHARGE-AM-PM.

9 Select the server kind from the Server Kind drop-down menu.

The server kind determines which metric subscriptions to assign to the EMC Smarts service. For example,
select the INCHARGE-AM-PM-SUITE server kind if the manager is INCHARGE-AM-PM and select the
INCHARGE-ESM-SUITE server kind if the manager is INCHARGE-ESM.

10 Select an auto-discovery option from the Auto Discovery drop-down menu.

Option Description

true Enables auto-discovery for the adapter instance. When auto-discovery is
enabled, the data collection process discovers new resources and creates the
resources in vCenter Operations Manager. You do not need to manually add
new resources.

false Disables auto-discovery for the adapter instance. When auto-discovery is
disabled, you must add resources manually.

 
11 In the Discovery Hour of Day (0-24) text box, type the hour of day, from 0 to 24, when

vCenter Operations Manager should check the EMC Smarts domain for new resources.

12 Select the credential to use to sign on to the data source from the Credential drop-down menu, or click
Add to add a new credential.

EMC Smarts Integration Guide
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13 (Optional) Click Test to test the adapter instance.

IMPORTANT   In pre-5.6 installations, this test does not provide accurate results if you configured an EMC
Smarts SecureBroker Credentials credential kind for the adapter instance. The test always fails, even when
the credentials are correct.

14 Click OK to save your configuration.

What to do next

By default, the adapter instance collects metrics every five minutes. To change this value, you must edit the
adapter instance resource in vCenter Operations Manager. For information about editing resources, see the
administration guide for your vCenter Operations Manager version.

Add a Credential
You must add a credential for an EMC Smarts adapter instance. The credential consists of a valid EMC Smarts
user name and password.

You can add the credential before you create the adapter instance and select the correct credential when you
define the adapter instance, or you can add the credential when you define the adapter instance.

Prerequisites

Install the EMC Smarts adapter. See Chapter 2, “Installing the EMC Smarts Adapter,” on page 11.

Procedure

1 Log in to the Custom user interface as an administrator.

2 Select Environment > Configuration > Credentials.

3 Select EMC Smarts from the Adapter Kind drop-dow menu.

4 Select a credential kind from the Credential Kind drop-down menu.

Option Description

EMC Smarts Credentials Select this credential kind if the EMC Smarts installation is in default mode.

EMC Smarts SecureBroker
Credentials

Select this credential kind if the EMC Smarts installation is in Secure Broker
mode.

 
5 At the top of the list of credentials, next to Action, click Add.

6 Type a unique name for the credential instance in the Instance name text box.

7 Type the user name and password to use to connect to EMC Smarts in the User Name and Password text
boxes.

8 If you selected EMC Smarts SecureBroker Credentials, type the Broker user name and password in the
Broker Username and Broker Password text boxes.

9 Click OK to add the credential for the adapter kind.

The credential appears in the list in the Manage Credentials window.

Chapter 3 Configuring EMC Smarts Integration
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Discover Resources
If you disable auto discovery when you add an EMC Smarts adapter instance, you must discover resources
manually. If you have multiple EMC Smarts adapter instances, discover resources for the AM, PM, or AM-PM
instances first followed by the ACM, ESM, and SAM instances.

Although the manual discovery process returns a list of all of the available resources for the adapter instance,
you need to add only one resource. After you perform the first manual discovery and add one resource,
vCenter Operations Manager adds any additional resources for the adapter instance as it receives metric data.

Prerequisites

n Add an adapter instance. See “Add an Adapter Instance,” on page 16.

n If you plan to define a new attribute package during the discovery process, become familiar with creating
attribute packages. For information about attribute packages, see the administration guide for your
vCenter Operations Manager version.

Procedure

1 Log in to the Custom user interface as an administrator.

2 Select Environment > Environment Overview.

3 On the List tab, click the Discover Resources icon.

4 Select the collector to use from the Collector drop-down menu.

Unless you added additional collectors, the only available collector is vCenter Operations Server. You
can change the name of this collector when you install the standalone version.

5 Select EMC Smarts from the Adapter Kind drop-down menu.

6 Select the EMC Smarts adapter instance from the Adapter Instance drop-down menu.

7 Select Initial Resource Import from the Discovery Info drop-down menu.

8 (Optional) To omit resources that have already been added from the discovery results, select the Only
New Resources check box.

If vCenter Operations Manager has not added resources for the adapter instance, selecting this check box
does not affect the discovery results.

9 Click OK to start the discovery process.

The discovery process can take several seconds to several minutes.

When the discovery process is finished, the Discovery Results window lists your resource kinds.

10 Add one resource to vCenter Operations Manager.

a Select an attribute package or click Add to add a new attribute package for the resource kind for the
resource.

b Double-click the resource kind to see the discovered resources.

c Select the Import and Collect check boxes for the resource to add.

d Click Save.

11 Click OK.

The Discovery Results window closes and the new resource appears on the List tab.
vCenter Operations Manager adds any additional resources for the adapter instance as it receives metric
data.

EMC Smarts Integration Guide
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What to do next

You might want to edit certain resources. For example, you might want to modify hard thresholds for a specific
resource or define super metrics for a container resource. For information about editing resources and defining
super metrics, see the administration guide for your vCenter Operations Manager version.

Configuring Outbound Alerts
To configure vCenter Operations Manager to send alerts to EMC Smarts, you must add an alert handler instance
and select the alerts to send.

Add an Alert Handler Instance
An alert handler instance sends alerts to a defined destination. If you have multiple Global Consoles, you can
add an alert handler instance for each console so that all vCenter Operations Manager alerts appear in each
console.

NOTE   If you use vCenter Operations Manager to track resources that are outside of the EMC Smarts system,
the alert handler instance also sends alerts for those resources.

Procedure

1 Log in to vCenter Operations Manager as an administrator.

2 Select Admin > Configure Outbound Alert.

3 Click the Add Alert Handler icon.

4 Select Smarts SAM Notification from the Outbound Alert Type drop-down menu.

5 Type a name for the alert handler instance in the Instance Name text box.

6 Type the host name or IP address of the EMC broker and the port number that it listens on in the
Broker text box.

Use a colon to separate the host name or IP address and the port number.

For example, if the IP address of the EMC broker is 123.45.6.789 and it listens on the default EMC port
(426), type 123.45.6.789:426.

7 Type the name of the SAM domain and server to which to send the alerts in the SAM Server text box.

8 Type a valid user name for the SAM server in the User Name text box and type the password for the user
name in the Password text box.

9 Click OK to save the alert handler instance.

What to do next

Select the alerts to send to EMC Smarts. See “Select Alerts to Send to EMC Smarts,” on page 19.

Select Alerts to Send to EMC Smarts
After you add an alert handler instance to send alerts to EMC Smarts, you must select the alerts to send. The
alert handler instance does not send alerts by default.

Prerequisites

n Add an alert handler instance. See “Add an Alert Handler Instance,” on page 19.

n Become familiar with the alert types and subtypes in vCenter Operations Manager. For more information,
see the administration guide for your vCenter Operations Manager version.

Chapter 3 Configuring EMC Smarts Integration
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Procedure

1 Open the plugin.properties file in a text editor.

The plugin.properties file is in the vcenter-ops/user/plugins/outbound/Smarts_alertplugin/conf
folder.

2 List the alerts to send in the sendByType property.

Type each alert type in the format Typen and each alert subtype in the format Subtypen. Separate alert
subtypes with a comma.

For example:

sendByType=Type1::Subtype1,Type1::Subtype2,Type2::Subtype1,Type2::Subtype2

3 Restart the Smarts SAM Notification alert handler instance.

a Log in to vCenter Operations Manager as an administrator.

b Select Admin > Configure Outbound Alert.

c Select the Smarts SAM Notification alert handler instance, click the Stop icon, and click the Start icon.

The Smarts SAM Notification alert handler instance sends the alert types that you selected to EMC Smarts.

Installing and Configuring the Global Console Custom View
You can install and configure the vCenter Operations Manager custom view so that operators can view alert
details in the Global Console.

NOTE   The Global Console custom view feature is not validated for EMC Smarts 9.0.

Install the Global Console Custom View
You install the vCenter Operations Manager custom view on the EMC Smarts server.

Prerequisites

n Verify that you have EMC Smarts 7.x or 8.1. The Global Console custom view feature is not validated for
EMC Smarts 9.0.

n Verify that you have the vcops_emc.jar file. If you have a standalone installation, vcops_emc.jar is in the
vcenter-ops/tools/smarts folder on the vCenter Operations Manager server. If you have a vApp
installation, you should have downloaded vcops_emc.jar when you installed the EMC Smarts adapter.
See “Install the Adapter in a vApp Installation,” on page 12.

Procedure

1 Copy the vcops_emc.jar file to the SmartsRoot/SAM/smarts/local/classes folder on the EMC Smarts
server.

SmartsRoot is the root folder of the EMC Smarts installation. The default root folder is InCharge7 for EMC
Smarts 7.x and InCharge8 for EMC Smarts 8.1.

2 On the EMC Smarts server, open the runcmd_env.sh file in a text editor.

The location of the runcmd_env.sh file depends on the EMC Smarts version.

Option Description

7.x SmartsRoot/SAM/smarts/local/conf/runcmd_env.sh

8.1 SmartsRoot/CONSOLE/smarts/local/conf/runcmd_env.sh
 

EMC Smarts Integration Guide
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3 Set the SM_CLASSPATH statement to the path for the vcops_emc.jar file.

For example:

SM_CLASSPATH= C:\InCharge7\SAM\smarts\local\classes\vcops_emc.jar

What to do next

Add the custom view to the Global Console. See “Add the Custom View in the Global Console,” on
page 21.

Add the Custom View in the Global Console
After you install the vCenter Operations Manager custom view on the EMC Smarts server, you must add the
custom view in the Global Console.

Prerequisites

Install the Global Console custom view. See “Install the Global Console Custom View,” on page 20.

Procedure

1 Open the Global Console.

2 Select View > Add View.

3 Select Custom View.

4 Type com.integrien.alive.alertsummary.AlertSummaryView in the Java Class text box.

5 Select a location for the custom view from the Panel and Tile drop-down menus.

6 Click OK to save your changes.

Installing and Configuring Integration Tools in EMC Smarts
You can install and configure the vCenter Operations Manager integration tools so that operators can view
resource details from the Global Console Notification Log and Topology Tree.

NOTE   The integration tools are not validated for EMC Smarts 9.0.

Install and Configure Integration Tools Files
You install and configure the vCenter Operations Manager integration tools files on the SAM server computer
and on each Global Console client.

Prerequisites

n Verify that you have EMC Smarts 7.x or 8.1. The integration tools are not validated for EMC Smarts 9.0.

n Verify that you have a valid EMC Smarts user name and password. The import command might prompt
you for these credentials.

n Verify that you have the Launch-vcops-UI-Object.cmd and launch-vcops-action-windows.xml files. If you
have a Standalone installation, the files are in the vcenter-ops/tools/smarts/Launch-vcops-UI-
Object.cmd folder on the vCenter Operations Manager server. If you have a vApp installation, you should
have downloaded the files when you installed the EMC Smarts adapter. See “Install the Adapter in a vApp
Installation,” on page 12.

Chapter 3 Configuring EMC Smarts Integration
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Procedure

1 Copy the Launch-vcops-UI-Object.cmd file to the SmartsRoot/SAM/smarts/local/actions/client folder
on each Global Console client computer.

SmartsRoot is the root folder of the EMC Smarts installation. The default root folder is InCharge7 for EMC
Smarts 7.x and InCharge8 for EMC Smarts 8.1.

2 Copy the launch-vcops-action-windows.xml file to the SmartsRoot/SAM/smarts/local/conf/ics folder on
the SAM server computer.

3 Open the Launch-vcops-UI-Object.cmd file in a text editor and set the VCOPS_HOST_PORT property to the IP
address and port number of the vCenter Operations Manager server.

4 Open the runcmd_env.sh file in a text editor and set the VCOPS_HOST_PORT property to the IP address and
port number of the vCenter Operations Manager server.

The location of the runcmd_env.sh file depends on the EMC Smarts version.

Option Description

7.x SmartsRoot/SAM/smarts/local/conf/runcmd_env.sh

8.1 SmartsRoot/CONSOLE/smarts/local/conf/runcmd_env.sh
 

5 Import the launch-vcops-action-windows.xml file.

The steps that you perform depend on whether the SAM server is a Windows or Linux system.

Option Action

Windows a Open a command prompt and change the directory to
SmartsRoot\SAM\smarts\local\conf\ics.

b Type the command ..\..\..\bin\sm_config -s SAM-DOMAIN
import --force launch-vcops-action-windows.xml, where SAM-
DOMAIN is the SAM domain name for the EMC Smarts deployment. The
SAM domain name is usually INCHARGE-SA.

Linux a Open a terminal window and change the directory to
SmartsRoot/SAM/smarts/local/conf/ics.

b Type the command ../../../bin/sm_config -s SAM-DOMAIN
import --force launch-vcops-action-windows.xml, where SAM-
DOMAIN is the SAM domain name for the EMC Smarts deployment. The
SAM domain name is usually INCHARGE-SA.

 
6 If the import command prompts you for credentials, type your EMC Smarts user name and password.

If the import is successful, the command does not return a message. The command returns a message only
if the import fails.

7 Restart the EMC Smarts service.

The service name is EMC Smarts Service Assurance Manager Server in EMC Smarts 7.x and EMC Ionix
Service Assurance Manager Server in EMC Smarts 8.1.

What to do next

Test the integration tools installation. See “Test the Integration Tools Installation,” on page 23.
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Test the Integration Tools Installation
After you install and configure the vCenter Operations Manager integration tools, test the tools to verify that
the installation was successful.

Prerequisites

Install and configure the vCenter Operations Manager integration tools. See “Install and Configure Integration
Tools Files,” on page 21.

Procedure

1 Stop and start the Global Console.

2 In the Global Console Notification Log, right-click a notification that originated in
vCenter Operations Manager and select Client Tools > View Object or Client Tools > Browse Object.

3 Verify that the Resource Detail page for the object related to the notification appears in a new browser
window.

The page URL should be similar to http://server/emcResponder.naaction?
mainAction=showResourceDetails&objectName=Host::10.1.10.17.

4 In the Topology Tree, right-click a UCS-type object, such as a switch or router, and select Client Tools >
Browse Object.

5 Verify that the Resource Detail page for the object appears in a new browser window.

The page URL should be similar to http://server/emcResponder.naaction?
mainAction=showResourceDetails&objectName=Host::10.1.10.17.

Configuring EMC Smarts Adapter Properties
vCenter Operations Manager discovers, imports, and collects data only for the resources and metrics that are
defined in the smarts_adapter.properties file. The smarts_adapter.properties file is in the vcenter-
ops/plugins/inbound/smarts_adapter/conf folder.

You can use a text editor to edit the smarts_adapter.properties file. Make a back up copy of the file before
you make changes. You must stop and restart the vCenter Operations Manager collector for your changes to
take effect.

NOTE   In a vApp installation, you edit the smarts_adapter.properties file on the Analytics virtual machine.

n EMC Smarts Adapter Properties File Format on page 24
The smarts_adapter.properties file contains properties that affect adapter operation, a series of
statements that define the parts of the EMC Smarts object hierarchy to include in
vCenter Operations Manager, and a series of topo statements that define relationships for container
resources.

n Defining Object Classes on page 26
Each classes statement in the smarts_adapter.properties file defines a part of the EMC Smarts object
hierarchy for a particular domain. Only objects defined by a classes statement are included when
vCenter Operations Manager performs resource discovery for an adapter instance for that domain.

n Defining Resource Topologies on page 27
Each topo statement in the smarts_adapter.properties file defines an EMC Smarts topology to be
replicated in vCenter Operations Manager. vCenter Operations Manager uses the information in the
topo statement to define an equivalent application topology in vCenter Operations Manager.
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n Add Threads on page 27
You can increase the number of threads and connections that vCenter Operations Manager generates to
collect metrics from each EMC Smarts adapter instance. Additional threads can improve performance,
but they can also use more domain resources.

n Configure White and Black Lists on page 28
You can configure the EMC Smarts adapter to use white and black lists to filter resources.

n Read Events From Notification Lists on page 28
EMC Smarts can store events in notification lists. You can configure the EMC Smarts adapter to read
events from these notification lists and send the events to vCenter Operations Manager.

n Enable Smart Discovery on page 29
You can configure the EMC Smarts adapter to use smart discovery to discover resources. When you
enable smart discovery, the EMC Smarts adapter performs full discovery during startup and whenever
EMC Smarts reports that it has finished its discovery process.

n Configure How the Adapter Handles Smarts Processor Metrics on page 30
You can configure how the EMC Smarts adapter handles Smarts processor metrics.

EMC Smarts Adapter Properties File Format
The smarts_adapter.properties file contains properties that affect adapter operation, a series of statements
that define the parts of the EMC Smarts object hierarchy to include in vCenter Operations Manager, and a
series of topo statements that define relationships for container resources.

The following example shows a smarts_adapter.properties file.

ThreadCount=2

AverageProcessors=true

DoSmartDiscovery=false

#classes

# First pair (:: separated) 

#   1) where to start (top/bottom)

#   2) the class to start with

#

# following this is any number of groups representing how to walk the class hierarchy

# each group is 3 items (:: separated)

#   1) Relationship type

#       1.1) op = Operation. This should be a class operation that returns a set of objects and 

takes no parameters.

#       1.2) rel = relationship. This is a normal multiple relationship property of the object 

(e.g. ComposedOf or InstrumentedBy)

#       1.3) rel1 = single relationship property. It returns only 1 item rather than an array (e.g. 

SystemName or SystemPackagedIn)

#   2)Relationship property name (should match the type) 

#   3)Base class to expect from the relationship.

#

# subscription is the list of properties to gather as metrics.

#topo

# One pair (:: separated)

#  First element is the smarts class to create the container from

#  Second element is the property to get the children of this container.

ICPM.classes.1=top::UnitaryComputerSystem op::getProcessors::Processor 
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               rel::InstrumentedBy::Processor_Performance

ICPM.subscription.1=CurrentUtilization

ICPM.classes.2=top::UnitaryComputerSystem op::getMemory::Memory 

               rel::InstrumentedBy::Memory_Performance

ICPM.subscription.2=BufferMissPct,BufferUtilizationPct,FreeMemory,FreeMemoryPct,

               LargestFreeBuffer,LargestFreeBufferPct,TotalBufferAllocationFailures,TotalMemory

#ICPM.classes.3=top::UnitaryComputerSystem rel1::SystemPackagedIn::Chassis

                rel::InstrumentedBy::Chassis_Performance

#ICPM.subscription.3=BackplaneUtilization

ICPM.classes.4=top::UnitaryComputerSystem op::getFileSystems::FileSystem

               rel::InstrumentedBy::FileSystem_Performance

ICPM.subscription.4=AvailableSpace,StorageSize,UtilizationPct

ICPM.classes.5=bottom::NetworkAdapter_Performance rel1::Instruments::NetworkAdapter

                op::getSystem::UnitaryComputerSystem

ICPM.subscription.5=AvgInputPacketSize,AvgOutputPacketSize,CurrentUtilization,

               InputPacketBroadcastPct,InputPacketBroadcastRate,InputPacketDiscardPct,

               InputPacketDiscardRate,InputPacketErrorPct,InputPacketErrorRate,

               InputPacketNoErrorRate,InputPacketQueueDropPct,InputPacketQueueDropRate,

               InputPacketRate,InputPacketsQueuedRate,MaxSpeed,MaxTransferUnit,

               OutputPacketBroadcastPct,OutputPacketBroadcastRate,OutputPacketDiscardPct,

               OutputPacketDiscardRate,OutputPacketErrorPct,OutputPacketErrorRate,

               OutputPacketNoErrorRate,OutputPacketQueueDropPct,OutputPacketQueueDropRate,

               ifInDiscardsRate,ifInErrorsRate,ifInNUcastPktsRate,ifInOctetsRate,

               ifInUcastPktsRate,ifInUnknownProtosRate,ifOutDiscardsRate,ifOutErrorsRate,

               ifOutNUcastPktsRate,ifOutOctetsRate,ifOutUcastPktsRate

ICPM.classes.6=top::UnitaryComputerSystem op::getVoltageSensors::VoltageSensor 

               rel::InstrumentedBy::VoltageSensor_Fault

ICPM.subscription.6=CurrentValue

ICPM.classes.7=top::UnitaryComputerSystem op::getTemperatureSensors::TemperatureSensor

               rel::InstrumentedBy::TemperatureSensor_Fault

ICPM.subscription.7=CurrentValue

ICPM.topo.1=VLAN::ConnectedSystems

ACM.classes.1=top::UnitaryComputerSystem rel::HostsServices::SoftwareService

              rel::CheckedBy::SoftwareElementCheck

#ACM.classes.1=bottom::SoftwareElementCheck rel::Checks::SoftwareService 

              op::getSystem::UnitaryComputerSystem

ACM.subscription.1=ResponseTime

ESM.classes.1=bottom::ICIM_Processor_Performance rel1::Instruments::ICIM_Processor

              op::getSystem::UnitaryComputerSystem

ESM.subscription.1=CurrentUtilization

ESM.classes.2=bottom::Memory_Performance_WMI rel1::Instruments::Memory

              op::getSystem::UnitaryComputerSystem

ESM.subscription.2=BufferMissPct,BufferUtilizationPct,FreeMemory,LargestFreeBuffer,

              TotalBufferAllocationFailures,TotalMemory,FreeKBytes,FreeMemoryPct,TotalKBytes 
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ESM.classes.3=bottom::FileSystem_Performance_WMI rel1::Instruments::FileSystem

              op::getSystem::UnitaryComputerSystem

ESM.subscription.3=AvailableSpace,Mounted,StorageSize,FreeSpaceKB,TotalSizeKB,UtilizationPct 

ESM.classes.4=bottom::SpCounter_Instrumentation rel1::Instruments::SpCounter

              op::getSystem::UnitaryComputerSystem

ESM.subscription.4=spProcessCount,spProcessCountRate

SAM.topo.1=RedundancyGroup::ComposedOf

SAM.topo.2=HierarchicalGroup::ConsistsOf

SAM.topo.3=HierarchicalGroup::ChildGroups

SAM.topo.4=ServiceOffering::ConsistsOf

SAM.events.NotificationListName=Default

SAM.events.ValidClasses=UnitaryComputerSystem

SAM.events.NotificationEvent=Down,Unresponsive

#experimental

classfields.UnitaryComputerSystem=Model,Vendor

Defining Object Classes
Each classes statement in the smarts_adapter.properties file defines a part of the EMC Smarts object
hierarchy for a particular domain. Only objects defined by a classes statement are included when
vCenter Operations Manager performs resource discovery for an adapter instance for that domain.

Each classes statement is followed by a subscription statement, which lists the metrics that
vCenter Operations Manager can collect for the objects defined by the classes statement.

Sample classes Statement
The following example shows a classes statement.

ICPM.classes.4=top::UnitaryComputerSystem op::getFileSystems::FileSystem

                        rel::InstrumentedBy::FileSystem_Performance

ICPM.subscription.4=AvailableSpace,StorageSize,UtilizationPct

The classes statement contains the following components:

n A statement name

n A starting point

n One or more object definition groups

n A subscription statement

Statement Name
The statement name consists of the domain name, the word classes, and a sequential number. Each value is
separated by periods. The statement name ends with an equals sign. The statement name in the sample
classes statement is ICPM.classes.4=.

Starting Point
The starting point specifies whether to start at the top or bottom of the object hierarchy. It also defines the
object class with which to start. The starting point in the sample classes statement is
top::UnitaryComputerSystem.
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Object Definition Groups
An object definition group describes the object hierarchy from the starting point to an object. Each group
contains a relationship type, relationship property name, and the base class to expect from the relationship.
Each value is separated by double colons (::).

The relationship type can be op, rel, or rel1.

op A class operation that takes no parameters and returns a set of objects.

rel A normal multiple-relationship property of the object, such as ComposedOf or
InstrumentedBy.

rel1 A single-relationship property of the object. It returns only one item rather than
an array, for example, SystemName or SystemPackagedIn.

In the sample classes statement, the first object definition is op::getFileSystems::FileSystem. This object
definition performs an operation on the getFileSystems property and returns a list of FileSystem names.

You can include any number of object definition groups in the smarts_adapter.properties file. Each group
must be separated by a single space.

Subscription Statement
The subscription statement lists the parameters for vCenter Operations Manager to collect for the objects that
are defined by the classes statement. The subscription statement consists of the statement name and a list of
EMC Smarts properties for the defined objects.

The statement name matches the classes statement name, except it is labeled subscription instead of
classes. The subscription statement name in the sample classes statement is ICPM.subscription.4=.

vCenter Operations Manager imports the properties in the EMC Smarts properties list as metrics for discovered
resources. The properties in the sample subscription statement are
AvailableSpace,StorageSize,UtilizationPct.

Defining Resource Topologies
Each topo statement in the smarts_adapter.properties file defines an EMC Smarts topology to be replicated
in vCenter Operations Manager. vCenter Operations Manager uses the information in the topo statement to
define an equivalent application topology in vCenter Operations Manager.

Each topo statement consists of an object class and a property to get that class. For example, the following
topo statement defines the RedundancyGroup object class and ComposedOf property.

SAM.topo.1=RedundancyGroup::ComposedOf

The result of this statement is a list of the objects under RedundancyGroup that are derived from a UCS-type
object, such as a router or switch.

Add Threads
You can increase the number of threads and connections that vCenter Operations Manager generates to collect
metrics from each EMC Smarts adapter instance. Additional threads can improve performance, but they can
also use more domain resources.

Procedure

1 Open the smarts_adapter.properties file in a text editor.

In a vApp installation, modify the smarts_adapter.properties file on the Analytics virtual machine.
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2 Set the ThreadCount property to a number between 1 and 4.

Values higher than 4 result in little or no benefit in vCenter Operations Manager and can seriously degrade
performance in the EMC Smarts domain. The default is 2.

3 Restart the vCenter Operations Manager collector to make your changes take effect.

Configure White and Black Lists
You can configure the EMC Smarts adapter to use white and black lists to filter resources.

A match occurs when any part of a resource name contains a filter in the white or black list. For example, if
the filter is abc, all of the following resource names match the filter:

bobabc

abcabc

abcbob

bob.department.abc.com

Procedure

1 Open the smarts_adapter.properties file in a text editor.

In a vApp installation, modify the smarts_adapter.properties file on the Analytics virtual machine.

2 If you have a white or black list file, set the whiteFilterListFileName or blackFilterListFileName
property to the file name.

The file must contain one filter per line.

The following example shows the whiteFilterListFileName and blackFilterListFileName properties on
a Windows system:

whiteFilterListFileName=C:\vcops\whitelist.txt

blackFilterListFileName=C:\vcops\blacklist.txt

The following example shows the whiteFilterListFileName and blackFilterListFileName properties on
a Linux system:

whiteFilterListFileName=/var/opt/whitelist

blackFilterListFileName=/var/opt/blacklist

3 If you do not have a white or black list file, set the whiteFilterList or blackFilterList property to a
comma-separated list of filters.

For example:

whiteFilterList=abc,def,ghi

blackFilterList=abc,def,ghi

4 Restart the vCenter Operations Manager collector to make your changes take effect.

Read Events From Notification Lists
EMC Smarts can store events in notification lists. You can configure the EMC Smarts adapter to read events
from these notification lists and send the events to vCenter Operations Manager.

By default, the EMC Smarts adapter monitors the default notification list for all events of type Down or
Unresponsive that belong to the UnitaryComputerSystem class. When the adapter encounters an event that
matches these criteria, it sends the event to vCenter Operations Manager. EMC Smarts events appear as alerts
in the vCenter Operations Manager user interface. For information about viewing alerts in
vCenter Operations Manager, see the online help.
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Unlike performance metrics, which typically come from the INCHARGE-AM-PM suite, events typically come
from the INCHARGE-SA suite. You should create a separate EMC Smarts adapter instance to connect to the
SA suite to monitor for events.

Events from EMC Smarts appear for a resource in vCenter Operations Manager only if
vCenter Operations Manager is actively monitoring for that resource. The EMC Smarts adapter instance that
is monitoring for the resource must be running from the same collector as the adapter instance that is
monitoring for events.

Prerequisites

Create a separate EMC Smarts adapter instance to connect to the SA suite to monitor for events. See “Add an
Adapter Instance,” on page 16.

Procedure

1 Open the smarts_adapter.properties file in a text editor.

In a vApp installation, modify the smarts_adapter.properties file on the Analytics virtual machine.

2 Set the NotificationListName property to the name of the notification list to monitor for events.

The default setting is Default, which corresponds to the default notification list.

NOTE   Because notification list names are prepended with ICS_NL-, the actual name of the default
notification list is ICS_NL-Default.

3 Specify each class to monitor in the ValidClasses property.

The adapter filters out events for classes that are not in this list. Use a comma to separate multiple class
names in the list. The default setting is UnitaryComputerSystem.

4 Specify each event type to monitor in the NotificationEvent property.

The event types that you specify are dependent on the classes that you listed in the ValidClasses property.
Use a comma to separate mulitple events in the list. The default setting includes Down and Unresponsive,
which are specific to the UnitaryComputerSystem class.

NOTE   The event types that you specify are associated with all of the classes in the ValidClasses property.
You cannot specify a certain event type only for a certain class.

5 Restart the vCenter Operations Manager collector to make your changes take effect.

The EMC Smarts adapter captures the events that belong to the classes listed in ValidClasses and for which
an event type is specified in NotificationEvent.

Enable Smart Discovery
You can configure the EMC Smarts adapter to use smart discovery to discover resources. When you enable
smart discovery, the EMC Smarts adapter performs full discovery during startup and whenever EMC Smarts
reports that it has finished its discovery process.

When smart discovery is disabled (the default behavior), the EMC Smarts adapter performs full discovery
during startup and at the hour of day that you configured for the adapter instance.

Procedure

1 Open the smarts_adapter.properties file in a text editor.

In a vApp installation, modify the smarts_adapter.properties file on the Analytics virtual machine.
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2 Set the DoSmartDiscovery property to true to enable smart discovery.

The default is false.

3 Restart the vCenter Operations Manager collector to make your changes take effect.

Configure How the Adapter Handles Smarts Processor Metrics
You can configure how the EMC Smarts adapter handles Smarts processor metrics.

Procedure

1 Open the smarts_adapter.properties file in a text editor.

In a vApp installation, modify the smarts_adapter.properties file on the Analytics virtual machine.

2 Set the AverageProcessors property.

Option Description

true The adapter averages Smarts processor metrics before sending the metrics
to vCenter Operations Manager. This is the default setting.

false The adapter does not average Smarts processor metrics and the Custom user
interface shows metrics for each processor individually.

 
3 Restart the vCenter Operations Manager collector to make your changes take effect.
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Viewing Alerts and EMC Smarts
Information 4

You can view vCenter Operations Manager alerts in EMC Smarts and you can view EMC Smarts information
in vCenter Operations Manager.

This chapter includes the following topics:

n “Viewing Alerts in EMC Smarts,” on page 31

n “Viewing EMC Smarts Information in vCenter Operations Manager,” on page 34

Viewing Alerts in EMC Smarts
When you configure vCenter Operations Manager to send alerts to EMC Smarts, alerts appear on the Global
Console Notification Log page in EMC Smarts.

Figure 4-1.  Global Console Notification Log Page

When you configure the vCenter Operations Manager custom view for the Global Console, you can click an
alert message in the Global Console Notification log to see alert details in the Global Console custom view
panel.
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Figure 4-2.  Global Console Custom View Panel

n The blue bar at the top of the page shows the type of alert, when it started, how long it lasted, and the
name of the resource that generated it. The internally assigned alert ID appears in the top right of the
custom view.

n The middle pane shows information about the event that triggered the alert, including the type of trigger,
the associated resource or metric, and details about the trigger.

n The bottom pane shows information related to the alert, including health information for the last six hours
for the associated resource and any subcontainers. It also shows a metric graph for up to five metrics for
the resource. Breaching KPIs appear first, followed by breaching super metrics, non-breaching KPIs, and
non-breaching super metrics.

For information about resolving alerts, see the documentation for your vCenter Operations Manager version.

View Root Cause Information in the Global Console Custom View
You can view information about the calculated root causes of an alert on the Root Cause tab in the Global
Console custom view panel.

The Root Cause tab is similar to the Root Cause tab in the vCenter Operations Manager Alert Summary
window. For information about the Root Cause tab, see the documentation for your
vCenter Operations Manager version.

Prerequisites

Install and configure the Global Console custom view. See “Installing and Configuring the Global Console
Custom View,” on page 20.

Procedure

n Click the Root Cause tab in the Global Console custom view panel to see information about the calculated
root causes of the alert.

The information includes the likely root cause container resources ranked by the analytical algorithm on
the container resource.

n Double-click a resource on the Root Cause tab to see the symptom groups ranked by percentage of possible
resources that exhibit symptoms in the group.

n Double-click a group on the Root Cause tab to see the top five individual symptoms ranked by percentage
of possible resources that exhibit the symptom.
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View Alert Details from the Global Console Custom View
You can view alert details in vCenter Operations Manager from the Global Console custom view panel.

Prerequisites

Install and configure the Global Console custom view. See “Installing and Configuring the Global Console
Custom View,” on page 20.

Procedure

n Click the arrow at the top right of the Global Console custom view panel to open the Alert Detail page in
vCenter Operations Manager.

The Alert Detail page contains information that can help you troubleshoot an alert. It also contains icons
that you can click to update the status of an alert in vCenter Operations Manager.

n Click the resource name in the top line of the Global Console custom view panel to open the Dynamic
Dashboard page in vCenter Operations Manager.

The Dynamic Dashboard page shows detailed information about the resource that generated the alert.

If you are not logged in to vCenter Operations Manager, a prompt appears and you must log in before the
Alert Detail or Dynamic Dashboard page opens. Use a user name and password that has access rights to view
alert or resource details.

NOTE   vCenter Operations Manager opens in a new browser window or tab, depending on your browser
settings.

View Resource Details from the Global Console Notification Log
You can view resource details in vCenter Operations Manager from the Global Console Notification Log page.

Prerequisites

Install and configure the vCenter Operations Manager integration tools in EMC Smarts. See “Installing and
Configuring Integration Tools in EMC Smarts,” on page 21.

Procedure

1 Right-click an alert on the Global Console Notification Log page.

2 From the pop-up menu, select Client Tools > View Object or Client Tools > Browse Object.

If you are not logged in to vCenter Operations Manager, a prompt appears and you must log in before the
Resource Detail page opens. Use a user name and password that has access rights to view resource details.

NOTE   vCenter Operations Manager opens in a new browser window or tab, depending on your browser
settings.

View Resource Details from the Global Console Topology Tree
You can view resource details in vCenter Operations Manager from the Topology Tree in the Global Console.

Prerequisites

Install and configure the vCenter Operations Manager integration tools in EMC Smarts. See “Installing and
Configuring Integration Tools in EMC Smarts,” on page 21.

Procedure

1 Expand the Topology Tree to show the object.
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2 Right-click the object in the list.

3 From the pop-up menu, select Client Tools > View Object in vCenter Operations.

If you are not logged in to vCenter Operations Manager, a prompt appears and you must log in before the
Resource Detail page opens. Use a user name and password that has access rights to view resource details.

NOTE   vCenter Operations Manager opens in a new browser window or tab, depending on your browser
settings.

Viewing EMC Smarts Information in vCenter Operations Manager
You can view EMC Smarts information in vCenter Operations Manager dashboards and widgets. A dashboard
can contain any combination of vCenter Operations Manager widgets. Each widget shows a specific view of
a type of collected data.

For information about using and configuring dashboards and widgets, see the documentation for your
vCenter Operations Manager version.

Resource Health Dashboard Example
This dashboard shows the overall health of a section of the resource tree.

Figure 4-3.  Dashboard that Shows Resource Health

n The Resources widget lists the EMC Smarts resources defined in vCenter Operations Manager and the
health score for each resource.

n The Advanced Health Tree widget shows the parent and child relationships for the resources selected in
the Resources widget. The resources are color-coded by health.

n The Root Cause Ranking widget shows the metrics that vCenter Operations Manager has determined are
the biggest contributors to the health problem of the selected resources.
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Real-Time Performance Dashboard Example
This dashboard shows the real-time performance of the CPU use and overall health metrics for all of the
resources imported from EMC Smarts.

Figure 4-4.  Real-Time Performance Information

Each Heat Map widget shows a color-coded square for each defined resource. Red indicates a poorly
performing resource and green indicates good performance. The predominate color of the widget indicates
the overall performance of the metric.

You can click a resource square to show the root cause metrics for the performance problems of that resource
in the Root Cause Ranking widget.

Metric Performance Charts Dashboard Example
This dashboard shows performance charts for selected metrics for the previous six hours, including the
minimum and maximum values, the moving average value, and the calculated dynamic thresholds for the
metric.

Figure 4-5.  Performance Charts for Selected Metrics

When you select a resource and metrics on the left, a graph shows the metric data in the Metric Graph widget
on the right. The Metric Graph widget offers many options of chart type, time period, and what to include on
the graph.
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Finding Nonexistent EMC Smarts Resources
The EMC Smarts adapter creates the SMARTS Entity Status resource tag in the vCenter Operations Manager
user interface. You can select the NotExisting value for this resource tag to find resources that the EMC Smarts
adapter discovered that were later removed in EMC Smarts.

When resources are removed in EMC Smarts, they remain in the vCenter Operations Manager user interface
until you delete them.

The NotExisting resource tag value includes the name of the EMC Smarts adapter instance and the number of
resources that are no longer present in EMC Smarts. The adapter instance in the following example is named
smartsAMPM and one resource is no longer present in EMC Smarts.

Figure 4-6.  SMARTS Entity Status Resource Tag

NOTE   Only resources that are no longer present in EMC Smarts are tagged NotExisting. If a resource stops
providing metrics and it is still present in EMC Smarts, it is not tagged NotExisting.
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Troubleshooting the EMC Smarts
Adapter 5

Known troubleshooting information can help you diagnose and correct problems with the EMC Smarts
adapter.

This chapter includes the following topics:

n “Troubleshooting an EMC Smarts Adapter Instance,” on page 37

n “Viewing System Log Files,” on page 37

n “Resolving Common Problems,” on page 38

Troubleshooting an EMC Smarts Adapter Instance
Perform these general troubleshooting steps to diagnose and correct problems with an EMC Smarts adapter
instance.

1 Verify that you can connect to the host for the EMC broker.

2 Verify that you configured the correct credential kind for the adapter instance. See “Add a Credential,”
on page 17.

3 Verify the collection status and collection state of the EMC Smarts adpater instance resource on the
Environment Overview page in vCenter Operations Manager. For more information about viewing
resources in the user interface, see the online help.

4 Check the adapter and collector logs for errors. See “Viewing System Log Files,” on page 37.

Viewing System Log Files
You can view EMC Smarts adapter errors in the adapter and collector log files in
vCenter Operations Manager. You can view adapter and collector log files in the user interface or in an external
log viewer.

EMC Smarts adapter log files are in the vcenter-ops/user/log/adapters folder. Collector log files are in the
vcenter-ops/users/log folder.

The logging level is set to ERROR by default. To troubleshoot issues, set the logging level to INFO. To view
detailed messages, including micro steps, queries, and returned results, set the logging level to DEBUG.

You can set the log level for each class in the log4.properties file in the vcenter-ops/log/conf/collector
folder, for example:
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log4.logger.com.integrien.adapter3.symmetrix.objects.LunDataPointObject=DEBUG

NOTE   If you set the logging level to DEBUG, log files can become large very quickly. Set the logging level to
DEBUG only for short periods of time.

For information about viewing log files and modifying logging levels, see the online help.

Resolving Common Problems
Follow recommended procedures when you resolve problems with the EMC Smarts adapter.

Log Files Contain Class Not Found Errors
The log files contain exceptions of type MR-E-CLASS_NOT_FOUND_EX.

Problem

Exceptions similar to the following example appear in the log files:

2012-08-15 18:13:37,853 ERROR [Collector worker thread 8] (3547) 

com.integrien.adapter3.smarts.connection.icServerAccess.printSmRemoteExceptionMsg - 

SmRemoteException: An Exception has occured in a remote Domain Manager. 

com.smarts.remote.SmRemoteException: MR-E-CLASS_NOT_FOUND_EX-Cannot find class 

'SpCounter_Instrumentation'; in file 

"t:/DMT-9.0.0.X/1304/smarts/repos/servif/SM_RepositoryServer.c" at line 555 

at com.smarts.remote.SmRemoteInterfaceHandler.getResponse(SmRemoteInterfaceHandler.java:116)

Cause

The EMC Smarts service and server kind are not configured correctly for the EMC Smarts adapter instance or
the referenced class does not exist in the EMC Smarts system.

When you add an EMC Smarts adapter instance, you type the name of the EMC Smarts service in the
Manager text box and select the server kind from the Server Kind drop-down menu. If these values do not
match, the adapter instance looks for metrics in a service where the metrics are not defined. For information
about configuring the EMC Smarts service and server kind, see “Add an Adapter Instance,” on page 16.

A subscription might invoke a class that does not exist in the EMC Smarts system if you modify the
smarts_adapter.properties file to subscribe to more metrics than the default subscriptions. For information
about modifying classes in the smarts_adapter.properties file, see “Defining Object Classes,” on page 26.

Solution

Edit the adapter instance and correct the EMC Smarts service or server kind, or comment out the subscription
that is invoking the missing class in the smarts_adapter.properties file.

Log Files Contain Object Not Found Errors
The log files contain exceptions of type MR-E-OBJECT_NOT_FOUND.

Problem

When an object in EMC Smarts no longer exists, errors similar to the following example appear in the log files:

2012-03-12 12:26:49,908 ERROR [Smarts Collection Thread (Instance:414) worker thread 2] (414) 

com.integrien.adapter3.smarts.workitem.CollectWorkItem.run - Error getting data for instance I-

Port_Performance_MIB2-PORT-10.118.52.34/1

2012-03-12 12:26:49,908 INFO [Smarts Collection Thread (Instance:414) worker thread 2] (414) 

com.integrien.adapter3.smarts.workitem.CollectWorkItem.run - 

com.smarts.remote.SmRemoteException: MR-E-OBJECT_NOT_FOUND-Object of given name and class 
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NetworkAdapter_Performance::I-Port_Performance_MIB2-PORT-10.118.52.34/1 not found; in file 

"t:/DMT-9.0.0.X/1304/smarts/repos/mr/dyn_acc.c" at line 1587

at com.smarts.remote.SmRemoteInterfaceHandler.getResponse(SmRemoteInterfaceHandler.java:116)

at com.smarts.remote.SmRemoteInterfaceHandler.getProperties(SmRemoteInterfaceHandler.java:4817)

at com.smarts.remote.SmRemoteInterfaceHandler.getProperties(SmRemoteInterfaceHandler.java:4791)

at com.integrien.adapter3.smarts.connection.icServerAccess.getPropertyValues(icServerAccess.java:

373)

at 

com.integrien.adapter3.smarts.workitem.FullDiscoveryCollectWorkItem.getMetricValues(FullDiscovery

CollectWorkItem.java:471)

at com.integrien.adapter3.smarts.workitem.CollectWorkItem.collect(CollectWorkItem.java:65)

at com.integrien.adapter3.smarts.workitem.CollectWorkItem.run(CollectWorkItem.java:36)

at com.integrien.alive.common.util.ThreadPool$WorkerItem.run(ThreadPool.java:224)

at java.util.concurrent.ThreadPoolExecutor$Worker.runTask(ThreadPoolExecutor.java:886)

at java.util.concurrent.ThreadPoolExecutor$Worker.run(ThreadPoolExecutor.java:908)

at java.lang.Thread.run(Thread.java:619)

If the collector process reaches the limit of open handles, exceptions occur in different processes, for example:

2012-03-10 01:39:53,233 ERROR [Collector worker thread 20] (416) 

com.integrien.adapter3.smarts.connection.icServerAccess.checkDomainConnected - Exception trying 

to reconnect

java.net.SocketException: Too many open files

at java.net.Socket.createImpl(Socket.java:397)

at java.net.Socket.<init>(Socket.java:371)

at java.net.Socket.<init>(Socket.java:218)

at com.smarts.net.JI_FlowTCP.doOpen(JI_FlowTCP.java:331)

at com.smarts.net.JI_FlowPhysical.open(JI_FlowPhysical.java:203)

at com.smarts.net.JI_Flow.connectToServer(JI_Flow.java:684)

at com.smarts.net.JI_Flow.connectToServer(JI_Flow.java:632)

at com.smarts.remote.SmRemoteDomainManager.attach(SmRemoteDomainManager.java:494)

at com.smarts.remote.SmRemoteDomainManager.attach(SmRemoteDomainManager.java:427)

at com.smarts.remote.SmRemoteBroker.attach(SmRemoteBroker.java:197)

at 

com.integrien.adapter3.smarts.connection.icServerAccess.checkDomainConnected(icServerAccess.java:

168)

at com.integrien.adapter3.smarts.SmartsAdapter.startEventProcessThread(SmartsAdapter.java:967)

at com.integrien.adapter3.smarts.SmartsAdapter.onCollect(SmartsAdapter.java:227)

at com.integrien.alive.common.adapter3.AdapterBase.collectBase(AdapterBase.java:552)

at com.integrien.alive.common.adapter3.AdapterBase.collect(AdapterBase.java:371)

at com.integrien.alive.collector.CollectorWorkItem3.run(CollectorWorkItem3.java:42)

at com.integrien.alive.common.util.ThreadPool$WorkerItem.run(ThreadPool.java:224)

at java.util.concurrent.ThreadPoolExecutor$Worker.runTask(ThreadPoolExecutor.java:886)

at java.util.concurrent.ThreadPoolExecutor$Worker.run(ThreadPoolExecutor.java:908)

at java.lang.Thread.run(Thread.java:619)

Cause

TCP connections are continously allocated. This problem can occur if the EMC Smarts adapter build is earlier
than 650155.

Solution

Upgrade the EMC Smarts adapter to a build later than 650155.

Chapter 5 Troubleshooting the EMC Smarts Adapter
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